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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any
products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections
of the other component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Connect and Disconnect Properly. Connect the probe output to the measurement instrument before
connecting the probe to the circuit under test. Connect the probe reference lead to the circuit under test
before connecting the probe input. Disconnect the probe input and the probe reference lead from the circuit
under test before disconnecting the probe from the measurement instrument.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product.
Consult the product manual for further ratings information before making connections to the product.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it
inspected by qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

Terms in this Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other
property.
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Introduction Using Online Help

Introduction

Using Online Help
Select Help from the menu to open the help file. You can also find an electronic copy of the help file in the
Documents directory on the 063-4068-XX DVD.

Tables of Contents (TOC) tab—Organizes the help into book-like sections. Select a book icon to open a
section; select any of the topics listed under the book.

Index tab— Enables you to scroll a list of alphabetical keywords. Select the topic of interest to bring
up the appropriate help page.

Search tab— Allows a text-based search.

Follow these steps:

1. Type the word or phrase you want to find in the search box. If the word or phrase is not found, try the
Index tab.

2. Choose a topic in the lower box, and then select the Display button.

General Help Functions:
Select the Print button from the Help topics menu bar to print a topic.

To return to the previous window, select the Back button.

Use hyperlinks to jump from one topic to another.

If the back button is grayed out or a jump is not available, choose the Help Topics button to return to
the originating help folder.
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Introduction Related Documentation

Related Documentation
In addition to this TekExpress DisplayPort Online Help, the following documentation is included with
the software:

DisplayPort Standard Tektronix MOI for Sink Tests method of implementation document.

TekExpress DisplayPort Online Help (PDF version), Tektronix part number 077-0233-00.

Conventions
Online Help uses the following conventions:

The term “DUT” is an abbreviation for Device Under Test.

The term “select” is a generic term that applies to the two mechanical methods of choosing an option:
using a mouse or using the touch screen.

Table 1: Icon descriptions
Icon Meaning

This icon identifies important information.

This icon identifies conditions or practices that could result in loss of data.

This icon identifies additional information that will help you use the
application more efficiently.
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Introduction Technical Support

Technical Support
Tektronix values your feedback on our products. To help us serve you better, please send us your
suggestions, ideas, or comments on your application or oscilloscope.

When you contact Tektronix Technical Support, please include the following information (be as specific as
possible):

General Information
All instrument model numbers.

Hardware options, if any.

Probes used.

Your name, company, mailing address, phone number, FAX number.

Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application Specific Information
Software version number.

Description of the problem such that technical support can duplicate the problem.

If possible, save the setup files for all the instruments used and the application.

If possible, save the TekExpress setup files, log.xml and status messages text file.

If possible, save the waveform on which you are performing the measurement as a .wfm file.

Forward the information to technical support using one of these methods:

E-mail – techsupport@tektronix.com

FAX – (503) 627-5695
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Getting Started Accessories

Getting Started

Accessories

About the Efficere Test Fixture
The Efficere text fixtures ET-DP-TPA-S that facilitate Sink Compliance testing are manufactured
and distributed by Efficere Technologies. Efficere ET-DP-TPA-S can also be ordered directly from
Tektronix. Efficere specializes in the design of high-speed products with superior signal integrity. For
more information, visit the Efficere Technologies Web site www.Efficere.com.
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Getting Started Minimum System Requirements

Minimum System Requirements
The minimum system requirements for a PC to run TekExpress are as follows:

Table 2: System requirements
Processor Pentium 4/M or equivalent processor.
Operating System Windows XP Service Pack 2.
Memory 512 MB of memory.
Hard Disk Approximately 2 GB of available hard-disk space for the recommended

installation, which includes full TekExpress installation and distributed
components.

Drive DVD drive
Display Super VGA resolution or higher video adapter (800x600 minimum video

resolution for small fonts or 1024x768 minimum video resolution for large fonts).
The application is best viewed at 96 dpi display settings 1.

Software IConnect S-parameter software (80SSPAR) for Cable testing.

DPOJET and SerialXpress for Sink testing.

Microsoft Excel 2002 or above.

Microsoft Internet Explorer 6.0 SP1 or later.

Microsoft Photo Editor 3.0 or equivalent software for image files viewing.

Adobe Reader 6.0 or equivalent software for viewing portable document
format (PDF) files.

Other Devices Microsoft compatible mouse or compatible pointing device.

Four USB ports (2 USB ports minimum).

PCI-GPIB or equivalent interface for instrument connectivity 2.
1 If TekExpress is running on an instrument having a video resolution lower than 800x600 (for example, sampling oscilloscope), it is recommended

to connect a secondary monitor and this has to be enabled before launching the application.
2 If TekExpress is installed on a Tektronix oscilloscope, the virtual GPIB port cannot be used by TekExpress for communicating with oscilloscope

applications.
If external devices like USB-GPIB or equivalent are used for instrument connectivity, ensure that the Talker Listener utility is enabled in the
DPO/DSA oscilloscope’s GPIB menu.

6 TekExpress DisplayPort Automated Compliance Solutions



Getting Started Application Directories and Usage

Application Directories and Usage
Related Topics

File Name Extensions

How To Activate the License

View Test Related Files

The application directory and associated files are organized as follows:

The following table lists the default directory names and their usage:

Table 3: Default directory names and their usage
Directory names Usage
InstallDir\TekExpress Contains the application and associated files.
\TekExpress\Compliance Suites Has compliance specific sequence files. The folders

under this directory represent the devices to be
tested.

\TekExpress\Compliance Suites\DisplayPort\ Includes “Sink” folder.
\TekExpress\Compliance Suites\DisplayPort\Sink Includes the AUX controller “Available” and “Not

Available” folders.
\TekExpress\ACP
\TekExpress\SCP
\TekExpress\ICP

Includes instrument and application specific
interface libraries of TekExpress.

\TekExpress\Data Manager
\TekExpress\Data Storage
\TekExpress\Report Generator

Includes the result management specific libraries of
TekExpress are present in these folders.

\TekExpress\Documents Includes the Method of Implementation documents
and technical documentation for the application.

TekExpress DisplayPort Automated Compliance Solutions 7



Getting Started File Name Extensions

Table 3: Default directory names and their usage (cont.)

Directory names Usage
\TekExpress\Bin
\TekExpress\Lib
\TekExpress\Tools

Includes the Miscellaneous libraries of TekExpress.

File Name Extensions
Related Topics

Application Directories and Usage
How To Activate the License

The software uses the following file name extensions:

File name extension Description
.TekX The session file will be saved in this format.
.seq The test sequence file.
.xml The encrypted XML file that contains the test specific configuration

information. The log file extension is also xml.
.PDF The PDF file that details the method of implementation for the test.
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How To Activate the License
Related Topics

Application Directories and Usage
File Name Extensions

Follow the steps below to activate the license:

1. Click Help > About to view the license information.

2. Click the View Version Details link to check the version numbers of the installed test suites.

3. Click the View End-User License Agreement link to open the following Tektronix Software License
Agreement window. Click Print to print the License Agreement.

TekExpress DisplayPort Automated Compliance Solutions 9



Getting Started How To Activate the License

4. Click License Info to view the available software options. This window shows the license key and the
various options with their status (active or inactive) with the current license key.

5. If you are activating the license for the first time, the license key field will be empty. To activate
the license, connect the USB dongle to your computer, enter the license key provided in the license
key certificate, and click Activate. If the activation is successful, a sign is displayed next to
the license key field.

6. If you are reactivating the license, click Reactivate, enter the new license key and click Activate.
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Before You Click Run
After you first launch TekExpress, it creates the following folders on your computer:

\My Documents\My TekExpress

NOTE. Ensure that the “My TekExpress” folder has read and write access.

NOTE. If a user with a different Windows login ID launches TekExpress, a new My TekExpress folder is created
under that user’s My Documents folder

\My Documents\My TekExpress\DisplayPort.

\My Documents\My TekExpress\DisplayPort\Untitled Session. Every time the
DisplayPort.exe is launched a Untitled Session folder is created under DisplayPort folder.
The Untitled Session folder is deleted when you exit TekExpress.

CAUTION. Each session has multiple files associated with it. Do not modify any of the session files and/or folders as
this may result in loss of data or corrupted session files.

The My TekExpress folder is created as a shared folder with share name as <domain><user
ID> My TekExpress (or if the PC is not connected to domain then share name is <Computer
name><user ID> My TekExpress).

The above shared folder is mapped as X: (X drive) on to the PC where TekExpress is running.

NOTE. If X drive is mapped to any other shared folder, TekExpress will pop-up a Warning message window asking to
disconnect the X: drive manually.

Do the following before you click Run:

NOTE. Ensure that the network connectivity is enabled on the PC running the TekExpress.

1. Map the shared My TekExpress folder as X: (X drive) on all the instruments used in test setup
running Microsoft Windows Operating System. This share folder is used to save the waveform files
or any other file transfer operations.

2. Right click on the My TekExpress folder and open the Properties dialog box. Select General tab
and then Advanced. In the Advanced Attributes window, ensure that the option Encrypt contents
to secure data is NOT selected. Click here to view the picture.
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3. Ensure that the DisplayPort pattern file provided with TekExpress DVD are available on the respective
instruments. For more details, refer to the ReadmeFirst.txt located in the DisplayPort Setup

Files folder on the TekExpress DVD.

Mapping My TekExpress folder
To map the My TekExpress folder on the instruments, follow the steps below:

1. Open Windows Explorer.

2. From the Windows Explorer menu, select Tools > Map Network drive.

3. Select the Drive letter as X: (if there is any previous connection on X:, disconnect it first through
Tools > Disconnect Network drive menu of Windows Explorer).

4. In the Folder field, enter remote My TekExpress folder path (for example, \\192.158.97.65\
John’s My TekExpress)

5. You can determine the IP address of the PC where “My TekExpress” folder exists by doing the
following:

Select Start > Run menu on the PC where My TekExpress folder exists.

Enter cmd and click Enter.

At command prompt, type ipconfig.
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Operating Basics

TekExpress Application Overview
TekExpress is the Tektronix Compliance Characterization, and Debug Test Automation Framework,
developed to support current and future test automation needs of customers. Developed using National
Instruments’ TestStand, TekExpress leverages on the capabilities of Microsoft .NET framework. It is a
highly modular architecture that enables deploying automated test solutions for various serial standards
in a relatively short time. TekExpress provides a test automation solution for the DisplayPort CTS 1.1
standards.
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Starting the Application
Related Topics

Resizing the Application Window
Exiting the Application

The application uses a USB dongle that contains the license key. This dongle must be present on the PC or
the instrument hosting the TekExpress application.

The application also checks for a file, called Resources.xml, located in My TekExpress folder. If this file
is not found, instrument discovery is performed before launching TekExpress. The Resources.xml file
contains information regarding instruments available on network.

When the application starts, it checks for the appropriate license key. If the valid license key is not present,
the application switches to the “Demo” mode. If the application fails to detect the dongle, it continues
to run in Demo mode.

To start the application, you can do one of the following:

Click Start > Programs > Tektronix > TekExpress > TekExpress DisplayPort.

Double click the icon on the desktop.

If you have previously saved a session, you can double-click the session file stored under My
TekExpress\DisplayPort.

When the application is launched it displays the splash screen providing launch information. The
application also checks for the presence and validity of the USB dongle.

NOTE. If the application was not terminated properly during the last use, a dialog box asks to recall the previously
unsaved session.
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Resizing the Application Window
Related Topics

Starting the Application
Exiting the Application

To minimize the application, click on the application title bar. To restore the application to its

previous size, select in the Windows task bar.

To maximize the application, click . To restore it to previous size, click on the application
title bar.

Exiting the Application
Related Topics

Starting the Application
Resizing the Application Window

To exit the application, do one of the following:

Click File > Exit.

Click on the application title bar.
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Global Controls
The menus and controls that appear outside the individual tabs are called “Global Controls”. These are
used to specify the devices to be tested.

Table 4: Controls and Functions
Control name Function
DUT The device ID is specified at the global level and the

information is stored in the default location for all data
files. This field cannot be empty and does not allow these
special characters (.,..,...,\,/:?”<>|*). The maximum length
of characters allowed is 32.
You will be able to run/stop the tests.

Menus
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File Menu
Related Topics

View Menu
Tools Menu
Help Menu

Click File on the application menu bar.

The File menu has the following selections:

Menu Function
New Session Starts a default session of TekExpress.
Open Session Opens a saved session.
Save Session Saves the session.
Save Session As Saves a session in a different name.
Save Report As Saves the report in user specified location.
Print Preview Report Previews the report before printing.
Print Report Opens the Windows “Print” dialog box.
Recent Sessions Lists recent sessions.
Exit Closes the application.
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View Menu
Related Topics

File Menu
Tools Menu
Help Menu

Click View on the application menu bar.

The View menu has the following selections:

Menu Function
Log File Opens the log (log.xml) file in the default viewer.
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Tools Menu
Related Topics

File Menu
View Menu
Help Menu

Click Tools on the application menu bar.

The Tools menu has the following selections:

Menu Function
Instrument Bench Opens a dialog box showing the list of instruments attached to the test setup.

Tools > Instrument Bench
The Instrument Bench window shows the list of VISA and Non-VISA resources found on different
interfaces/connections. It serves two purposes at the launch of TekExpress:

Discovers the connected instruments.

Confirms the instrument connection setup.

When you click Tools > Instrument Bench, the following dialog box is displayed:
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Search Criteria: The various connections on which you can search. Non-VISA Resources are the
instruments that cannot be searched using TekVISA.

Retrieved Instruments: Displays the count and details of instruments that were discovered.

Last Updated: Displays the time when the last time search was performed.

TekVISA Refresh Timeout (Seconds): This time out specifies the maximum time that TekExpress
can wait for TekVISA update.

NOTE. TekExpress uses TekVISA for instrument search. Ensure that TekVISA is running on your system before
you refresh the instrument bench window.

Table 5: Retrieved Resources properties in the Instrument Bench window
Title Description
Connection Shows the type of connection with the instrument.
Resource Shows the name of the resource.
Serial Number Shows the serial number of the resource.
Options Shows the options available on the instrument. 1

Resource Address Shows IP Address/Port number of the resource.
1 The option column displays the options that fit in the field. To view complete options on the instrument, move the mouse cursor over the option.

Table 6: Button controls on Instrument Bench dialog box
Button Function
Refresh The application searches on the selected connection for resources. While

searching resources it shows the Instrument Bench discovery window. The
Discovery window shows the connection currently being scanned and the
percentage of task completed.

Close Closes the dialog box.
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Help Menu
Related Topics

File Menu
View Menu
Tools Menu

Click Help on the application menu bar.

The Help menu has the following selections:

Selection Description or Function
TekExpress Help Displays TekExpress Help (F1).
About TekExpress... Displays application details such as software name, version

number and copyright.
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How To

Select the Test(s)
Related Topics

View and Select Connected Instruments
Configure and Run the Tests
View the Progress of Analysis
View the Report
View Test Related Files

The application tests DisplayPort Sink devices to ensure that the device passes the DisplayPort CTS
Jitter Tolerance test.

The Select panel allows you to select tests to configure and run.
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This panel provides the following functions:

Select Device
Select the Device type. And the test suite options will be automatically updated corresponding to the
device selected.

Select Lanes
Select the Lane number(s) that will be tested.

Select Test Suite
The application allows you to select a subset of tests to execute. Based on the test suite selected, the
Version drop-down list will be populated.

Version
You can select the appropriate version. For example, CTS 1.1.

NOTE. If any of the check boxes in the Select column is grayed, you cannot make any changes. It implies that the
test is mandatory.

Once you select a row, the following options are available:

Table 7: Button controls on the Select panel
Button Description

Opens the configuration panel for the selected test.

Opens the PDF of method of implementation (MOI) for the selected test.

Opens the schematic for the selected test. This is useful if you want to
verify the test setup before running the test.

Selects all tests in the table.

Selects all the DisplayPort required tests in the grid and deselects all
informative tests in the table.

Deselects all tests in the table.
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Configure and Run the Test(s)
Related Topics

Select the Tests
View and Select Connected Instruments
View the Progress of Analysis
View the Report
View Test Related Files

The configuration panel is used to create, view, and edit the parameters associated with the acquisition and
the analysis of the selected test.

You have the following options:

To choose between running the tests in a Compliance or User Defined mode.

To restore compliance mode values.

To change the parameters associated with the configuration of acquisition.

To change the parameters associated with analysis configuration.

The upper half of the Configure panel has general parameters that are common for all the tests under the
selected test suite that are editable. The lower half of the Configure panel has test specific parameters.

NOTE. If any of the test parameters are grayed, it means that these parameters cannot be modified in the compliance
mode. When you switch to the user-defined mode, these parameters are editable.
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Table 8: Test parameters
Parameters to configure Description
Analyze parameters Shows the various parameters

related to analysis of a selected
test. These parameters can vary
from one test to another such as,
Jitter values.

Test Limits Applies to a specific test. It shows
the maximum number of bit errors
for the test.

Comments You can specify a comment up to
256 characters long for the selected
test. The comments will be printed
on the report.

Compliance settings
Restores the compliance settings.

Accepts all changes that you made.

Dismisses the dialog box and does
not apply changes.

Click Run in the Select panel to run the selected tests.

Refer to the following table for different test limit comparisons:

Table 9: Different test limit comparisons
Comparison string Description
EQ(==) Equal to
NE(!=) Not equal to
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Table 9: Different test limit comparisons (cont.)

Comparison string Description
GT(>) Greater than
LT(<) Less than
GE(>=) Greater than or Equal to
LE(<=) Less than or Equal to
GTLT(><) Greater than and Less than
GELT(>=<) Greater than or equal to and Less than
GTLE(><=) Greater than and Less or equal to
LTGT(<>) Less than and Greater than
LEGE(<= >=) Less than or equal to and Greater than or equal to
LEGT(<= >) Less than or equal to and Greater than
LTGE(< >=) Less than and Greater than or equal to
GELE(>= =<) Greater than or equal to and Less than or equal to
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View and Select Connected Instruments
Related Topics

Select the Tests
Configure and Run the Tests
View Test Related Files
View the Progress of Analysis
View the Report

Viewing Connected Instruments
The Tools > Instrument Bench menu item is used to discover connected instruments required for the
tests. The application uses TekVISA to discover the connected instruments. Once the operation is done,
the Instrument Bench dialog box resumes operation and lists the instrument-related details based on the
selected search criteria.

NOTE. When the TekVISA Instrument Manager checks for connected instruments, the Instrument Bench dialog
box is unresponsive.

For example, if you select LAN as the search criteria in the Instrument Bench dialog box and click Refresh,
the TekVISA Instrument Manager checks for the instruments availability over LAN and the details of
the instrument are displayed under Retrieved Instruments table.

You can provide the time in the TekVISA Timeout (Seconds) field, within which if the TekVISA
Instrument Manager does not find the instruments, the TekExpress application resumes operation.

If you choose Non-VISA resources, all the instruments supported by TekExpress but not communicating
over the VISA layer can be searched.
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Selecting Connected Instruments
You can view the instruments connected in the Configuration panel. The upper half of the panel displays
the general parameters for the tests under the selected test suite.

You can choose the instruments from the drop-down list as shown in the following figure:

NOTE. The list of instruments displayed is specific to the selected test suite. It does not show all the connected
instruments.
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View the Progress of Analysis
Related Topics

Select the Tests
View and Select Connected Instruments
Configure and Run the Tests
View the Report
View Test Related Files

You can view the progress of the analysis in the Analyze panel. When the analysis is complete, the result
value of each test is updated.

Analysis Table
The table contains the following:

The test name.

The status of the tests that are being run.

The Tests that are not yet started are shown with a “To be Started” status. A summarized status of the
currently running test is shown on the status.

The Status Messages window timestamps all runtime messages and displays them. You can do the
following:

Display Status: Enable/Disable status messages.

Auto Scroll: The status messages are scrolled automatically.

Clear All: Clear all status messages in Status Window.
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Save Status: Save all status messages in text file. Displays a standard save file window and saves the
status messages in the user specified file.

NOTE. The Status Messages window is dockable and can be resized.
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View the Report
Related Topics

Select the Tests
View and Select Connected Instruments
Configure and Run the Tests
View the Progress of Analysis
View Test Related Files

After the analysis, a report is automatically generated and displayed in the report panel. The report shows
the results of the tests, including device information and pass/fail status of each test.

The Report View Area contains an HTML version of the report template. You can select any area of the
report and copy it to the clipboard to make it available to other applications.

NOTE. You need to install Microsoft Excel 2002 before using the “View Scorecard” option.
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View Test Related Files
Related Topics

Application Directories and Usage

All the test related files for currently selected tests are always saved under My Documents\My

TekExpress\DisplayPort\Untitled Session.

When you save a session, it is saved with the session name under the path My Documents\My

TekExpress\DisplayPort\SessionName for future references.

The session that is currently running will be stored in the same path as “Untitled” until you save it.

WARNING. Do not save Sessions in the name “Untitled” and “Backup” as they are application specific files and
will be deleted when the application exits.

A session folder can contain results for more than one DUT, and a DUT folder can contain more than one
run data folder marked by date-time stamp as folder name.

Below is an example image of data storage:
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Generate Patterns
For details on DisplayPort pattern creation, refer to the DisplayPort Standard Tektronix Method
Of Implementation for Sink Tests document. Also, you can open the document by clicking

option in the Select Panel.
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Application Examples
Sink Receiver Compliance Test

Jitter Tolerance Test for Lane 0: Equipment
Setup

You need the following equipment to set up the application:

Resource Model supported
High Speed Signal Source Tektronix AWG7102 (Options 01, 06)
Real Time Oscilloscope Tektronix DPO/DSA 72004, DPO/DSA 71604, DPO/DSA 71254, TDS6154C,

and TDS6124C
Test Fixtures TPA-P and TPA-R fixtures from Efficere Technologies
Attenuators Tek P/N: 015-1002-01 (14dB) – 6 numbers.

Tek P/N: 015-1001-01 (6dB) – 4 numbers.
DC Block - Picosecond Pulse Lab 5501A – 2 (for Analog output)

Connect the equipment as shown in the following diagram:
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Jitter Tolerance Test for RBR in
Semi-Automated mode

To run a Sink Jitter Tolerance test, follow these steps:

1. Select Sink as the device type.

2. Select Lane 0 as the lane to be tested.

3. Select Tektronix AUX Controller Not Available (Semi-Automated Test) option and CTS 1.1 as
the version.

4. Enter the DUT name in the DUT field.

5. If you want to verify the test setup before running the test(s), click Show Schematic.

6. Select 4.1a - Jitter Tolerance Test - RBR - 2MHz option.

7. Click Configure to configure the test parameters. Observe that the default settings are in the
Compliance mode.
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8. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.

9. You can configure any test to help you analyze measurement results. To refer to the DisplayPort
Standard Tektronix MOI for Sink Tests document for information on how to manually configure the
Jitter Tolerance tests, click Show MOI in the Select panel.

10.Click Apply to apply the new settings for the selected test. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.
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11.Click Run to run the selected tests.

The status of the tests is displayed in the Analyze panel.

12.The Testing is done in two phases - Frequency lock phase and symbol lock phase.

If the Tektronix AUX Controller is not available, a dialog box notifies whether to enable the sink
device for frequency lock. Click Yes and continue.

13.If the Tektronix AUX Controller is not available, a dialog box notifies whether to enable the sink
device for symbol lock. Click Yes and continue.

14.Click OK to enable the error counter.
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15.Enter the number of transmitted error bits in the following dialog box.

16. After the tests run successfully, a report is generated and displayed in the Report panel.

You can save the report using File > Save Report As option.
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Jitter Tolerance Test for RBR in Automated
Mode

1. Select Sink as the device type.

2. Select Lane 0 as the lane to be tested.

3. Select Tektronix AUX Controller Available (Automated Test) option.

4. Enter the DUT name in the DUT field.

5. If you want to verify the test setup before running the test(s), click Show Schematic.

6. Select 4.1b - Jitter Tolerance Test - RBR - 10MHz option.

7. Click Configure to configure the test parameters. Observe that the default settings are in Compliance
mode.
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8. If you want to change the parameters, choose User Defined Mode. The message reports that the
changes made to a test may no longer be compliant.

9. You can configure any test to help you analyze measurement results. To refer to the DisplayPort
Standard Tektronix MOI for Sink Tests document for information on how to configure the sink test,
click Show MOI in the Select panel.

10.Click Apply to apply the new settings for the selected test. If you want to restore the default settings,
click Restore. To close the dialog box, click Close.
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11.Click Run to run the selected tests.

The status of the tests is displayed in the Analyze panel.

12.After the tests run successfully, a report is generated and displayed in the Report panel.
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TekExpress Pattern Sequence

Pattern Sequence
TekExpress Display Port Software needs to have the following sequencing of patterns to run compliance
automated test. The nomenclature of the patterns should be exactly same as shown in the sequence.

If you are using an AWG7102, click on the links below to see the file names and the sequence they
should follow:

HBR SSC

File name should be JT_SSC_HBR_7102.awg.

Sequence:
1. Freq_Lock_HBR_2MHz

2. Symbol_Lock_HBR_2MHz

3. PRBS7_HBR_Clean

4. PRBS7_128times_1bit_errors

5. PRBS7_HBR_Clean

6. PRBS7_HBR_2MHz

7. PRBS7_HBR_Clean

8. Freq_Lock_HBR_10MHz

9. Symbol_Lock_HBR_10MHz

10.PRBS7_HBR_Clean

11.PRBS7_128times_1bit_errors

12.PRBS7_HBR_Clean

13.PRBS7_HBR_10MHz

14.PRBS7_HBR_Clean

15.Freq_Lock_HBR_20MHz

16.Symbol_Lock_HBR_20MHz

17.PRBS7_HBR_Clean

18.PRBS7_128times_1bit_errors

19.PRBS7_HBR_Clean

20.PRBS7_HBR_20MHz

21.PRBS7_HBR_Clean

22.Freq_Lock_HBR_100MHz
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23.Symbol_Lock_HBR_100MHz

24.PRBS7_HBR_Clean

25.PRBS7_128times_1bit_errors

26.PRBS7_HBR_Clean

27.PRBS7_HBR_100MHz

28.PRBS7_HBR_Clean

RBR SSC

File name should be JT_SSC_RBR_7102.awg.

Sequence:
1. Freq_Lock_RBR_2MHz

2. Symbol_Lock_RBR_2MHz

3. PRBS7_RBR_Clean

4. PRBS7_128times_1bit_errors

5. PRBS7_RBR_Clean

6. PRBS7_RBR_2MHz

7. PRBS7_RBR_Clean

8. Freq_Lock_RBR_10MHz

9. Symbol_Lock_RBR_10MHz

10.PRBS7_RBR_Clean

11.PRBS7_128times_1bit_errors

12.PRBS7_RBR_Clean

13.PRBS7_RBR_10MHz

14.PRBS7_RBR_Clean

15.Freq_Lock_RBR_20MHz

16.Symbol_Lock_RBR_20MHz

17.PRBS7_RBR_Clean

18.PRBS7_128times_1bit_errors

19.PRBS7_RBR_Clean

20.PRBS7_RBR_20MHz

21.PRBS7_RBR_Clean
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HBR Non-SSC

File name should be JT_Non SSC_HBR_7102.awg.

Sequence:
1. Freq_Lock_HBR_2MHz

2. Symbol_Lock_HBR_2MHz

3. PRBS7_HBR_Clean

4. PRBS7_128times_1bit_errors

5. PRBS7_HBR_Clean

6. PRBS7_HBR_2MHz

7. PRBS7_HBR_Clean

8. Freq_Lock_HBR_10MHz

9. Symbol_Lock_HBR_10MHz

10.PRBS7_HBR_Clean

11.PRBS7_128times_1bit_errors

12.PRBS7_HBR_Clean

13.PRBS7_HBR_10MHz

14.PRBS7_HBR_Clean

15.Freq_Lock_HBR_20MHz

16.Symbol_Lock_HBR_20MHz

17.PRBS7_HBR_Clean

18.PRBS7_128times_1bit_errors

19.PRBS7_HBR_Clean

20.PRBS7_HBR_20MHz

21.PRBS7_HBR_Clean

22.Freq_Lock_HBR_100MHz

23.Symbol_Lock_HBR_100MHz

24.PRBS7_HBR_Clean

25.PRBS7_128times_1bit_errors

26.PRBS7_HBR_Clean

27.PRBS7_HBR_100MHz
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28.PRBS7_HBR_Clean

RBR Non-SSC

File name should be JT_Non SSC_RBR_7102.awg.

Sequence:
1. Freq_Lock_RBR_2MHz

2. Symbol_Lock_RBR_2MHz

3. PRBS7_RBR_Clean

4. PRBS7_128times_1bit_errors

5. PRBS7_RBR_Clean

6. PRBS7_RBR_2MHz

7. PRBS7_RBR_Clean

8. Freq_Lock_RBR_10MHz

9. Symbol_Lock_RBR_10MHz

10.PRBS7_RBR_Clean

11.PRBS7_128times_1bit_errors

12.PRBS7_RBR_Clean

13.PRBS7_RBR_10MHz

14.PRBS7_RBR_Clean

15.Freq_Lock_RBR_20MHz

16.Symbol_Lock_RBR_20MHz

17.PRBS7_RBR_Clean

18.PRBS7_128times_1bit_errors

19.PRBS7_RBR_Clean

20.PRBS7_RBR_20MHz

21.PRBS7_RBR_Clean

If you are using an AWG7122, click on the links below to see the file names and the sequence they
should follow:

HBR SSC

File name should be JT_SSC_HBR_7122.awg.
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Sequence:
1. Freq_Lock_HBR_2MHz

2. Symbol_Lock_HBR_2MHz

3. PRBS7_HBR_Clean

4. PRBS7_128times_1bit_errors

5. PRBS7_HBR_Clean

6. PRBS7_HBR_2MHz

7. PRBS7_HBR_Clean

8. Freq_Lock_HBR_10MHz

9. Symbol_Lock_HBR_10MHz

10.PRBS7_HBR_Clean

11.PRBS7_128times_1bit_errors

12.PRBS7_HBR_Clean

13.PRBS7_HBR_10MHz

14.PRBS7_HBR_Clean

15.Freq_Lock_HBR_20MHz

16.Symbol_Lock_HBR_20MHz

17.PRBS7_HBR_Clean

18.PRBS7_128times_1bit_errors

19.PRBS7_HBR_Clean

20.PRBS7_HBR_20MHz

21.PRBS7_HBR_Clean

22.Freq_Lock_HBR_100MHz

23.Symbol_Lock_HBR_100MHz

24.PRBS7_HBR_Clean

25.PRBS7_128times_1bit_errors

26.PRBS7_HBR_Clean

27.PRBS7_HBR_100MHz

28.PRBS7_HBR_Clean

RBR SSC

File name should be JT_SSC_RBR_7122.awg.
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Sequence:
1. Freq_Lock_RBR_2MHz

2. Symbol_Lock_RBR_2MHz

3. PRBS7_RBR_Clean

4. PRBS7_128times_1bit_errors

5. PRBS7_RBR_Clean

6. PRBS7_RBR_2MHz

7. PRBS7_RBR_Clean

8. Freq_Lock_RBR_10MHz

9. Symbol_Lock_RBR_10MHz

10.PRBS7_RBR_Clean

11.PRBS7_128times_1bit_errors

12.PRBS7_RBR_Clean

13.PRBS7_RBR_10MHz

14.PRBS7_RBR_Clean

15.Freq_Lock_RBR_20MHz

16.Symbol_Lock_RBR_20MHz

17.PRBS7_RBR_Clean

18.PRBS7_128times_1bit_errors

19.PRBS7_RBR_Clean

20.PRBS7_RBR_20MHz

21.PRBS7_RBR_Clean

HBR Non-SSC

File name should be JT_Non SSC_HBR_7122.awg.

Sequence:
1. Freq_Lock_HBR_2MHz

2. Symbol_Lock_HBR_2MHz

3. PRBS7_HBR_Clean

4. PRBS7_128times_1bit_errors

5. PRBS7_HBR_Clean
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6. PRBS7_HBR_2MHz

7. PRBS7_HBR_Clean

8. Freq_Lock_HBR_10MHz

9. Symbol_Lock_HBR_10MHz

10.PRBS7_HBR_Clean

11.PRBS7_128times_1bit_errors

12.PRBS7_HBR_Clean

13.PRBS7_HBR_10MHz

14.PRBS7_HBR_Clean

15.Freq_Lock_HBR_20MHz

16.Symbol_Lock_HBR_20MHz

17.PRBS7_HBR_Clean

18.PRBS7_128times_1bit_errors

19.PRBS7_HBR_Clean

20.PRBS7_HBR_20MHz

21.PRBS7_HBR_Clean

22.Freq_Lock_HBR_100MHz

23.Symbol_Lock_HBR_100MHz

24.PRBS7_HBR_Clean

25.PRBS7_128times_1bit_errors

26.PRBS7_HBR_Clean

27.PRBS7_HBR_100MHz

28.PRBS7_HBR_Clean

RBR Non-SSC

File name should be JT_Non SSC_RBR_7122.awg.

Sequence:
1. Freq_Lock_RBR_2MHz

2. Symbol_Lock_RBR_2MHz

3. PRBS7_RBR_Clean

4. PRBS7_128times_1bit_errors
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5. PRBS7_RBR_Clean

6. PRBS7_RBR_2MHz

7. PRBS7_RBR_Clean

8. Freq_Lock_RBR_10MHz

9. Symbol_Lock_RBR_10MHz

10.PRBS7_RBR_Clean

11.PRBS7_128times_1bit_errors

12.PRBS7_RBR_Clean

13.PRBS7_RBR_10MHz

14.PRBS7_RBR_Clean

15.Freq_Lock_RBR_20MHz

16.Symbol_Lock_RBR_20MHz

17.PRBS7_RBR_Clean

18.PRBS7_128times_1bit_errors

19.PRBS7_RBR_Clean

20.PRBS7_RBR_20MHz

21.PRBS7_RBR_Clean
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TekExpress Programmatic Interface

About Programmatic Interface
Related Topics

Server and Client Proxy Objects

The Programmatic interface allows you to seamlessly integrate the TekExpress test automation application
with the high-level automation layer. This also allows you to control the state of TekExpress application
running on a local or a remote PC. Following operations can be performed using the programmatic
interface exposed by TekExpress:

Query DUT ID

Set DUT ID

SaveSession

RecallSession

Run the TekExpress execution

Stop the TekExpress execution

Query execution status

Transfer result files

For simplifying the descriptions, the following terminologies are used in this section:

TekExpress Client: A High level automation application that communicates with TekExpress using
TekExpress Programmatic Interface.

TekExpress Server: The TekExpress application when being controlled by TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for TekExpress Client.
TekExpress provides a client library for TekExpress clients to use the programmatic interface. The
TekExpress client library is inherited from .Net MarshalByRef class to provide the proxy object for the
clients. The TekExpress client library maintains a reference to the TekExpress Server and this reference
allows the client to control the server state.
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Click on the following links to get details on them:

What does one need to have to develop TekExpress Client ?

While developing TekExpress Client one needs to use the TekExpressClient.dll. The client can be a VB
.Net, C# .Net, TestStand or web application. The examples for interfaces in each of these applications
are in Samples folder.

References required
TekExpressClient.dll has internal reference to IIdlglib.dll and IRemoteInterface.dll IIdlglib.dll has a
reference to TekDotNetLib.dll. IRemoteInterface.dll provides the interfaces required to perform the remote
automations. It is an interface that forms the communication line between the server and the client.
IIdlglib.dll provides the methods to generate and direct the secondary dialog messages at the client-end.

NOTE. The end-user client application does not need any reference to above mentioned DLL files. It is essential
to have these DLLs (IRemoteInterface.dll, IIdlglib.dll and TekDotNetLib.dll) in same folder location as that of
TekExpressClient.dll.

What steps does a Client need to follow ?

The following are the steps that a client needs to follow to use the TekExpressClient.dll to programmatically
control the server:

A client UI has to be developed to access the interfaces exposed through the server. This client needs to
load TekExpressClient.dll to access the interfaces. Once the TekExpressClient.dll is loaded, the
client UI can call the specific functions to run the operations requested by the client. Once the client is up
and running, it has to do the following to run a remote operation:

1. The client needs to provide the IP address of the PC at which the server is running in order to connect to
the server.

2. The client needs to lock the server application to avoid conflict with any other Client that may try to
control the server simultaneously. “Lock” would also disable all user controls on server so that server
state cannot be changed by manual operation.

3. If any other client tries to access a server which is locked, it will get a notification that the server
is locked by another client.

4. When the client has connected to and locked the server, the client can access any of the programmatic
controls to run the remote automations.

5. Once the client operations are completed, the server needs to be “unlocked” by the Client.
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Server and Client Proxy Objects

Remote Proxy Object
The server exposes a remote object to let the remote client access and perform the server side operations
remotely. The proxy object is instantiated and exposed at the server-end through marshalling.

The following is an example:

RemotingConfiguration.RegisterWellKnownServiceType (typeof (TekExpressRe-

moteInterface), “TekExpress Remote interface”, WellKnownObjectMode.Singleton);

This object lets the remote client access the interfaces exposed at the server side. The client gets the
reference to this object when the client gets connected to the server.

For example,

//Get a reference to the remote object

remoteObject = (IRemoteInterface)Activator.GetObject(typeof(IRemoteInterface),

URL.ToString());
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Client Proxy Object
Client exposes a proxy object to receive certain information.

For example,

//Register the client proxy object

WellKnownServiceTypeEntry[] e = RemotingConfiguration.GetRegisteredWell-

KnownServiceTypes();

clientInterface = new ClientInterface();

RemotingConfiguration.RegisterWellKnownServiceType(typeof(ClientInterface),

“Remote Client Interface”, WellKnownObjectMode.Singleton);

//Expose the client proxy object through marshalling

RemotingServices.Marshal(clientInterface, "Remote Client Inteface");

The client proxy object is used for the following:

1. To get the secondary dialog messages from the server.

2. To get the file transfer commands from the server while transferring the report.

Click here to see examples.

clientObject.clientIntf.DisplayDialog(caption, msg,iconType, btnType);

clientObject.clientIntf.TransferBytes(buffer, read, fileLength);
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To know more on the topics below, click on the links.

Secondary Dialog Message Handling

The secondary dialog messages from the Secondary Dialog library are redirected to the client-end when a
client is performing the automations at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to be displayed is checked
and if a remote connection is detected, the messages are directed to the remote end.

File Transfer Events

When the client requests the transfer of the report, the server reads the report and transfers the file by
calling the file transfer methods at the client-end.
Programmatic Interface APIs
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Connect()

Connect(string ipAddress, out string clientID)
This method connects the client to the server. The client provides the ip address of the server to connect to
the server. The server provides a unique clientId when the client is connected to it.

Parameters

Name Type Direction Description
ipAdress string IN The ip address of the server to which the client is

trying to connect to. This is required to establish
the connection between the server and the client.

clientid String OUT Identifier of the client that is connected to the
server.
clientId = unique number + ipaddress of the
client. For example, 1065–192.157.98.70

Return Value
Value that suggests the status if the connection was established or an error occurred. The return value is an
object that can be a boolean value, returning true or a string, returning the error message.

Example
try {

IPAddress[] hostIPAddr = Dns.GetHostAddresses(Dns.GetHostName());

// Connect to the remoter Server

remoteObject.Connect(hostIPAddress, clientInterface, out clientID);

return true;

}

catch (Exception error)

{

return error;

}

Comments
The server has to be active and running for the client to connect to the server. Any number of clients can
be connected to the server at a time. Each client will get a unique id.
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Disconnect()

Disconnect(string id)
This method disconnects the client from the server it is connected to.

Parameters

Name Type Direction Description
id String IN Identifier of the client that is performing

the remote function.

Return Value
Integer value that suggests the status of the operation after it has been performed.

1 – Success

–1 – Failure

Example
try

{

string returnVal = UnlockServer (clientId);

remoteObject.Disconnect (clientId);

return 1;

}

Comments
When the client is disconnected, it is unlocked from the server and then disconnected. The id is reused.
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LockSession()

LockSession(string id)
This method locks the server. The client has to call this method before running any of the remote
automations. The server can be locked by only one client.

Parameters

Name Type Direction Description
id String IN Identifier of the client that is performing

the remote function.

Return Value
String value that suggests the status of the operation after it has been performed.

Example
if (locked)

return “Session has already been locked!”;

returnVal = remoteObject.LockSession(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

{

locked = true;

return “Session Locked...”;

}

Comments
When the client tries to lock a server that is locked by another client, the client gets a notification that the
server is already locked and it has to wait until the server is unlocked.

If the client locks the server and is idle for a certain amount of time then the server is unlocked
automatically from that client.
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UnlockSession()

UnlockSession(string id)
This method unlocks the server from the client. The client id of the client to be unlocked has to be provided.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.UnlockSession(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

{

locked = false;

return “Session Un-Locked...”;

}

Comments
When the client is disconnected, it is automatically unlocked.
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SetTimeOut()

SetTimeOut (string id, string time)

Parameters

Name Type Direction Description
id string IN Identifier of the client that

is performing the remote
function.

time string IN The time in seconds which
refers to the time-out
period.

Return Value
String that suggests the status of the operation after it has been performed.

Example
if (ClientId == ClientID)

{

if (locked == true)

{

tempTime = Int32.Parse(time);

}

if (tempTime < 0)

return “Enter a valid Timeout Period”;

else

{

timeout = tempTime;

return “Timeout Period Changed”;

}

}

62 TekExpress DisplayPort Automated Compliance Solutions



TekExpress Programmatic Interface GetTimeOut()

Comments
The time parameter gives the time-out period, that is the time the client is allowed to be locked and idle.
After the time-out period if the client is still idle, it gets unlocked.

The time parameter should be a positive integer. If it is not a positive integer, the client is prompted to
provide a valid time-out period.

GetTimeOut()

GetTimeOut (string id)

Parameters

Name Type Direction Description
id string IN Identifier of the client that

is performing the remote
function.

Return Value
String that suggests the status of the operation after it has been performed.

Example
if (ClientId == ClientID)

{

ResetTimer();

return timeOut.ToString();

}

Comments
The timeout period is a positive integer.
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GetDutId()

GetDutId(string id, string dutId)
This method gives the DUT id of the current set-up.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
dutId string OUT The DUT id of the set-up.

Return Value
String that gives the timeout period (in seconds) of the client.

Example
returnVal = remoteObject.GetDutId(clientId, out id);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

{

return id;

}

else

return CommandFailed(returnVal);

Comments
The dutId is an OUT parameter whose value is set after the server processes the request.

64 TekExpress DisplayPort Automated Compliance Solutions



TekExpress Programmatic Interface ChangeDutId()

ChangeDutId()

ChangeDutId(string id, string dutName)
This method changes the DUT id of the set-up. The client has to provide a valid DUT id.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
dutName string IN The new DUT id of the set-up.

Return Value
String that suggests the status of the operation after it has been performed.

Example
If (dut Id.Length <=0 && locked == true)

return “Enter a valid DUT-ID”;

returnVal = remoteObject.ChangeDutId(clientId, dutId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “DUT Id Changed...”;

else

return CommandFailed(returnVal);

Comments
If the dutName parameter is null, the client is prompted to provide a valid DUT id.
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SaveSession()

SaveSession(string id, string name)
Saves the current session. The name of the session is provided by the client.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
name string IN The name of the session being saved.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.SaveSession(clientId,sessionName);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Session Saved...”;

else

return CommandFailed(returnVal);

Comments
The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.

Once the session is saved under ‘name’ you cannot use this method to save the session in a different name.
Instead SaveSessionAs can be used.
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SaveSessionAs()

SaveSessionAs(string id, string name)
Saves the current session in a different name every time this method is called. The name of the session is
provided by the client.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
name string IN The name of the session being saved.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.SaveSessionAs(clientId,sessionName);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Session Saved...”;

else

return CommandFailed(returnVal);

Comments
The same session is saved under different names using this method. The name parameter cannot be empty.
If it is empty, the client is prompted to provide a valid name.
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RecallSession()

RecallSession(string id, string name)
Recalls a saved session. The name of the session is provided by the client.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
name string IN The name of the session being recalled.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.RecallSession(clientId,sessionName);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Session Recalled...”;

else

return CommandFailed(returnVal);

Comments
The name parameter cannot be empty. If it is empty, the client is prompted to provide a valid name.
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Run()

Run(string id)
Runs the setup. Once the server is set up and is configured, it can be run remotely using this function.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.Run(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Run started...”;

else

return CommandFailed(returnVal);

Comments
When the run is performed the status of the run is updated periodically using a timer.
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Stop()

Stop(string id)
Stops the run operation.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.Stop(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Stopped...”;

else

return CommandFailed(returnVal);

Comments
When the session is stopped the client is prompted to stop the session and is stopped at the consent.
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QueryStatus()

QueryStatus(string id, out string[] status)
This method gives the status of the run as messages. The status messages are generated once the run
is started.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
status string array OUT The list of status messages generated

during run.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.QueryStatus(clientId, out statusMessages);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Status updated...”;

else

return CommandFailed(returnVal);

Comments
The status messages are updated periodically after the run begins. The status is an out parameter which is
set when the server processes the request.
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TransferReport()

TransferReport(string id, string filePath)
This method transfers the report generated after the run. The report contains the summary of the run. The
client has to provide the location where the report is to be saved at the client-end.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote funtion.
filePath string IN The location where the report has to be

saved in the client.

Return Value
String that suggests the status of the operation after it has been performed.

Example
returnVal = remoteObject.TransferReport(clientId);

if ((OP_STATUS)returnVal == OP_STATUS.SUCCESS)

return “Transferred...”;

else

return CommandFailed(returnVal);

Comments
If the client does not provide the location to save the report, the report is saved at C:\ProgramFiles.
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CheckSessionSaved()

CheckSessionSaved(string id, out bool saved)
This function is called when a check is to be made to know if the current session is saved.

Parameters

Name Type Direction Description
id string IN Identifier of the client that is performing

the remote function.
saved bool OUT Boolean which represents if the current

session is saved.

Return Value
Void

Example
if (clientId == ClientID)

{

returnVal = remoteObject.IsSessionSaved(id,out saved);

}

Comments
The saved parameter gives the boolean value suggesting if the current session is saved or not. This is used
as a check in SaveSession() and SaveSessionAs() Functions.
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ErrorCodes
The return value of the remote automations at the server-end is OP_STATUS which is changed to a string
value depending on its code and returned to the client.

The values of OP_STATUS are as follows:

Value Code Description
FAIL −1 The operation failed.
SUCCESS 1 The operation succeeded.
NOTFOUND 2 Server not found
LOCKED 3 The server is locked by another client, so operation cannot

be performed.
UNLOCK 4 The server is not locked. Lock the server before performing

the operation.
NULL 0 Nothing
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Example
The following is an example for NI TestStand Client available in the path, C:\Program
Files\Tektronix\TekExpress\Examples\Programmatic Interface\TestStand
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Troubleshooting

Instrument Connectivity
Related Topics

User Interface
TestStand Runtime Engine Installation

If the instrument(s) are displayed in TekVISA Instrument Manager but not in the TekExpress Instrument
Bench, check the following:

Only those instruments that respond to *idn? and *opt? queries successfully, are displayed in
Instrument Bench.

Ensure that VXI-11 Server is running on the instruments.

If Instrument initialization fails during test sequence execution, do the following:

It is observed that GPIB communication with instrument over Tek-VISA layer is not initialized if in
TekVISA Instrument manager the search criteria is turned-off even if valid instrument is connected in the
network. It is necessary to turn ON the respective search criteria by opening the TekVISA Instrument
manager.

User Interface
Related Topics

Instrument Connectivity
TestStand Runtime Engine Installation

The Acquire tab is disabled.

For a selected test suite, the test is performed on a live acquisition. If test(s) such as PHY-TSG-OOB can
be performed on pre-acquired waveforms, this tab is active.
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TestStand Run time Engine Installation
Related Topics

Instrument Connectivity
User Interface

Managing multiple versions of TestStand installed on the system.

TekExpress installs TestStand version 3.5 runtime engine. If you have versions other than 3.5, while
working with TekExpress, ensure that the version shipped with TekExpress is active. You can do so by
clicking Start > Programs > National Instruments > TestStand 3.5 > TestStand Version Selector.
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Test Limit is Single Sided
Related Topics

Instrument Connectivity
TestStand Runtime Engine Installation
User Interface

The test limit is single sided but report shows second value and value is shown as 0.

If the test limits are single sided for limits such as GT(>) Greater than, LT(<) Less than; then the second
value is by default 0 and is ignored by the test automation script. In such cases, while analyzing the
report the second value should be ignored.
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Report shows as NAN
Related Topics

Instrument Connectivity
TestStand Runtime Engine Installation
User Interface
Test Limit is Single Sided

Some of the result values in the report are shown as NAN.

NAN is IEEE definition for “Not a Number”. The possible causes are as follows:

The captured pattern (HFTP, MFTP, LFTP, LBP waveform files) for the analysis does not contain
a valid pattern.

The NAN value is commonly seen in TSG measurements when LFTP pattern is required for analysis
but the captured pattern is not true LFTP.

The NAN value can be seen in the final reports if a test algorithm does not successfully evaluate a
result due to one or more reasons listed above.

For trouble shooting, you can analyze the captured waveform using pattern analyzer utility which is
available in TekExpress\ACP folder. The patternAnalyzer.exe need to be run from MS DOS prompt
and takes the following command line argument:

patternAnalyzer.exe <InterfaceSpeed> <WaveformFile> <OutputTXTfile> where,

InterfaceSpeed should be specified as either Gen1 or Gen2.

Waveform file is complete waveform file path.

OutputTXTfile is output text file path.

For example, patternAnalyzer.exe “Gen2” “X:\DisplayPort\SavedSes-

sion\DUT001\20080206_185914\BISTL_HFTP_G2_Drive_DW2_Diff.wfm” “X:\results.txt”.
Open the contents of X:\results.txt to see the results.
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Reference

Shortcut Keys
The following table lists the short cut keys to access the application:

Table 10: Keyboard shortcut keys
Menu Shortcut keys
File Alt + F
New Session Ctrl + N
Open Session... Ctrl + O
Save Session... Ctrl + S
Save Session As... Alt + F + A
Print Preview Report Alt + F + V
Print Report... Ctrl + P
Recent Sessions Alt + F + E
Exit Ctrl + X
View Alt + V
Log File Ctrl + L
Tools Alt + T
Instrument Bench... Ctrl + I
Help Alt + H
TekExpress Help (F1) Alt + H + H
About... Alt + H + A
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Error Codes for TekExpress
The following table lists the error codes for the application. Most of the errors require that you restart
the system.

Table 11: Error codes and Description
Error Code Description
<10000 TestStand generated error.
10001 - 11000 – Data Manager related errors
10001 Insufficient Data. The Record could not be inserted. The following

fields are empty or have insufficient data.
10002 Could not retrieve the record. The specified index is not valid.
11001 - 14000 – ICP related errors
11001 Operation mode is not set as specified.
11002 SetUp file Error: Specified SetUp file is not set.
11003 Operation state is not set as specified.
11004 Specified waveform is not loaded into channel memory.
11005 Specified channel is not enabled.
11006 Interleave State could not be set to off.
12001 Operation State is not set to required value.
12002 Display state is not set to required value.
12003 Horizontal Scale is not set to required value.
12004 Vertical scale is not set to required value.
12005 Vertical Position is not set to required value.
12006 Deskew is not set to specified value.
12007 Out of Range Error-RunTime Error Message.
14001 - 18000 – SCP related errors
14001 Timeout Error: Application could not be activated.
14002 JIT3 Application is already running.
14003 Cannot activate JIT3 application. Some other application is running

on Scope.
14004 Error recalling the specified setup.
14005 Error setting the specified Sequencer State.
14006 Error in closing the Application.
14007 Error loading the default setup.
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A
About menu, 23
About TekExpress, 15
Activating License, 9
Analyze Parameters, 28
Application Summary, 15

B
Before clicking Run, 11

C
Client, 53
Compliance mode, 27
Configure button, 26
Controlling the Server, 54

D
Data Storage, 35
Default Directory Usage, 7
Directory Structure, 7
dongle, 16

E
Equipment Setup

Drive RSG-RMT, 37
Error Codes, 82
Exiting the Application, 17

F
File Name Extensions, 8

G
General parameters, 27
Global Controls, 18

I
Instrument Bench, 21
Instrument Bench menu, 30
Instrument discovery, 30
Instrument initialization, 77

Interface, 53
Interface commands

ChangeDutId, 65
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Disconnect, 59
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GetTimeOut, 63
LockSession, 60
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Run, 69
SaveSession, 66
SaveSessionAs, 67
SetTimeOut, 62
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Stop, 70
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L
Log File, 20

M
Mapping My TekExpress

folder, 11
Menus

File, 19
Help, 23
Tools, 21
View, 20

My TekExpress, 35
My TekExpress folder, 11

N
NAN, 80
Non VISA resources, 22

O
Overview, 15

P
Parameters to configure, 27
Pattern Sequence

AWG, 45
Indy(7102), 45
Shannon(7122), 48

Programmatic Interface, 53
Progress of Analysis, 32
Proxy Object

Client, 55
Remote, 55

R
Reactiving License, 9
Recent Sessions, 19
Related Documentation, 2
Report

NAN, 80
Report panel overview, 34
Resizing the Application, 17
Retrieved Instruments, 22
RSG test on SATA drive, 38
Run

Run button, 18
Run button, 18

S
Safety Summary, v
SATA devices, 25
Save

Report, 19
Session, 19

Select panel, 25
Selecting Connected

Instruments, 31
Server, 53
Session folder, 35
Shortcut Keys, 81
Show MOI button, 26
Show Schematic button, 26
Single Sided, 79
Software version, 23
Starting the Application, 16
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Test Limit

Single Sided, 79
Test Limits, 28
Test Parameters, 28
Test Related Files, 35
Test Suite, 26

Test(s)
Configure, 27
Report, 34
Select, 25

TestStand Client example, 75
TroubleShooting

Instrument Connectivity, 77
TestStand Run-time Engine

Installation, 78
User Interface, 77
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